WILDERNESS COAST PUBLIC LIBRARIES

Microsoft Windows XP

( Level One )

Deanna D. Ramsey, Technology Instructor

Wilderness Coast Public Libraries computer training & some equipment are made
possible by a Library Services and Technology Act (LSTA) Grant administered by the
State Library of Florida.



Microsoft Windows XP ( Level One)

WILDERNESS COAST PUBLIC LIBRARIES 2
DEANNA D. RAMSEY, TECHNOLOGY INSTRUCTOR

Turning on the Computer
=  Press the Power button
=  Wait patiently while the computer boots up.

Restarting the Computer

= (Click on Start and choose Shut Down
= Choose Restart the computer

= (Click on OK

Shutting Down the Computer

= (Click on Start and choose Shut Down
= Choose Shut down

= (Click on OK

Shutdown the Computer when it appears to be Frozen

= Hold down Ctrl and Alt and press Delete one time.

= |n the window, click on the Shutdown button.

=  OR Last Resort

= Press the power button on the computer and hold it down 10 seconds.

= Wait 20-30 seconds, then press the power button again to start the computer.

Basic Troubleshooting Tips
=  Shutting down a program that has “frozen”

= Hold down Ctrl and Alt and press Delete one time.

=  From the pop-up window choose Task List...

= (Click on the Applications tab.

= The window displays the tasks that are currently running.

= (Click on the name of the task that is not responding (it may have the words “not
responding” in the Status column).

= (Click on the End Task button.

The Windows Desktop

Overview:

= |cons, Programs, Folders, Shortcuts
= Start button

= Quick Launch toolbar

= Program buttons

= Notification area

= Recycle Bin
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Arranging Icons on the Desktop:
= Right click on the Desktop and choose Arrange Icons By.
= Show Desktop Icons — Hides or shows all desktop icons.
= Auto Arrange - Automatically arranges the desktop icons on the left of the screen.
o Choose Name, Size, Type, or Modified to specify the order in Auto Arrange (a
checkmark in front of an item, it is active).

Customizing the Desktop
Themes - A theme is a background with a set of sounds, icons, and other elements to help
personalize the computer.
Changing the Desktop Theme:
= More themes can be purchased from Microsoft.
= Right click on the Desktop and choose Properties.
= C(Click on the Themes tab.
= (Click on the down arrow in the Theme box and choose the desired theme (there is a
desktop theme for Windows Classic which makes the Desktop appear like previous
versions of the Windows operating system).
= (Click on OK.

Setting a Desktop Background:
= Right click on the Desktop and choose Properties.
=  (Click on the Desktop tab.
= |n the Background window, choose the desired background.
= Click on the down arrow in the Position box and choose to position of the background
(Center, Tile or Stretch). Note: For a solid color, choose None as the background and
then click on the Color button to choose the desired background color.
= (Click on OK.
Setting the Screen Saver:
= Right click on the Desktop and choose Properties.
= Click on the Screen Saver tab.
= (Click on the down arrow in the Screen saver box and choose the desired screen
saver (The My Pictures Slideshow shows a slideshow of pictures in a folder on the
computer).
= Click on the Settings button to change the settings of any screen saver (i.e. speed,
color, text, etc. -- each Screen Saver has different options).
= To preview the chosen screen saver, click on the Preview button.
= To stop the screen saver preview, move the mouse.
= (Click on OK.
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Changing the Appearance of Windows Elements:

Right click on the Desktop and choose Properties.

Click on the Appearance tab.

Click on the down arrow of the Windows and buttons box and choose Windows XP
style or Windows Classic style.

Click on the down arrow of the Color scheme box and choose the Default (blue),
Olive Green or Silver color scheme.

Click on the down arrow of the Font size box and choose a font size.

Click on OK.

Changing the Screen Resolution:

Right click on the Desktop and choose Properties.

Click on the Settings tab.

In the Screen Resolution section, click and drag the slide bar to change from 800 x
600 to 1024 x 768, etc. (the larger the screen resolution, the smaller the icons, text,
and other items on the desktop appear).

Click on OK.

The Start Menu

Left Side - Access to programs and items most commonly used by the user.

Right Side - Access to most commonly used Windows folders.

My Documents/My Pictures/My Music - The default storage location for files of all
kinds, including pictures, music, and movies. My Documents contains the default
folders of My Music and My Pictures.

My Recent Documents - Contains a list of documents worked on recently.

My Computer - The default folder that stores information about drives connected to
the computer.

My Network Places - Contains information about other computers and shared
folders on the network.

Control Panel - The default location for managing all kinds of programs and services
on the computer.

Network Connections - A folder that contains the dial-up and broadband
connections, as well as local area network connections.

Printers and Faxes - Shows installed printers, fax printers and helps in adding new
ones.

Help and Support - Windows XP help and support feature that can answer questions
and locate answers on the Internet.

Search - Helps find items on the computer or items on the Internet.

Run - The Run dialog box can be used to open programs, folders, documents or web
sites.

Log Off/Turn Off Computer/Switch User - These standard icons enable the user to
log off, shut down, or restart the computer, or switch the user.
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Manipulating Open Windows
= Minimize/Maximize/Restore a Window
= C(Click the appropriate button in the upper-right corner of the window.
=  Minimize button - Reduces the open window to a button on the taskbar.
= Maximize button - Expands the open window to fill the entire screen.
= Restore button - Restores a maximized window to its previous size.
= Close button - Closes a window and removes its button from the taskbar (double
click on the Title Bar to maximize/minimize the window).
=  Moving Open Windows
o Click on the Title Bar and drag the window to the desired location (a window
displayed full screen cannot be moved).

Resizing Open Windows

e Place the cursor over a border or corner of the window. (The cursor becomes a double-
headed arrow €<->)

e Click and drag the window to the desired size.

* Note: A window displayed full screen cannot be resized.

Common Features of Open Windows
=  Open My Documents (Start 2 My Documents)
Title Bar — The colored bar at the top.
o Control Menu — Left button
o Minimize Button
o Maximize/Restore Button
o Close Button
Menu Bar — (File, Edit, View, Favorites, etc.)
Toolbars (View = Toolbars =)
o Standard Buttons
o Address Bar — Displays location of the selected folder.
= Enter a web address and click on Go to go to a web address.
o Status Bar (View ->Status Bar =)
o Scroll Bars (if the information does not fit in the window, scroll bars are available
on the side, at the bottom, or both).
Working with Scroll Bars:
= Click the up or down arrows to move slowly through the screen.
= (Click and drag the scroll bar to the desired location.
= Click above or below the scroll bar to advance a full screen at a time.
= The wheel on the mouse can also be used to scroll up or down when the cursor is in
the window.
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Changing the View of Icons in Open Windows:

Open My Documents (Start = My Documents)

Click on View

Filmstrip (only available for My Pictures folder and folders with pictures)
Thumbnails (good for viewing photos and graphics)

Tiles, Icons, List and Details (shows name, size, type and date modified)

Navigating Using the Toolbar

Icon

Description

Returns to the previous window.

Moves forward to the next window.

Moves up a level. (Notice the address on the address bar.)

Opens the Search Companion window to allow searching for documents, pictures,
music, etc.

Changes the view of the left side of the window to show a list of storage locations
and folders rather than a list of common tasks.

Allows quick changes of the view of the window. Choose between Filmstrip,
Thumbnails, Tiles, Icons, List or Details.

Start Menu Style

Windows XP or Windows 95/98 Style:

Right click on the Start button and choose Properties.

Click on the Start Menu tab.

Choose Start menu to select the Windows XP Start menu.

Choose Classic Start menu to select the Windows 95/98 Start menu.
Click on OK.

Start Menu Appearance:

Right click on the Start button and choose Properties.

Click on the Start Menu tab.

Click on the Customize button.

Select Large icons or Small icons.

Select the Number of programs on Start menu. This is a list of shortcuts to programs
used most often.

Select the Internet browser and/or E-mail program to display them in the Start
menu. Remove the checkmark to not display these options.

Click on OK.
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Using Windows Accessories
Games:
= (Click on Start = All Programs = Games
= Games available without Internet Access
FreeCell
Hearts
Solitaire
Spider Solitaire
= Games available with Internet Access are prefaced with the word “Internet”

©)
©)
©)
©)

Using Windows Accessories
Calculator:
e Click on Start = All Programs > Accessories = Calculator.
= Performing a simple calculation
o Enter the first number in the calculation.

o Click on # to add, - to subtract, * to multiply, or / to divide.
o Enter the next number in the calculation.
o Enter any remaining numbers or operators.
o Click on the = sign.
= The numeric keypad on the keyboard can be used to enter numbers and operators.
o Make sure the NUM LOCK key is selected.
o To find out what specific keys do, right click on the key and choose What's
This?
= Performing scientific calculations
o On the Menu Bar, click on View = Scientific.
o Choose a Number System (Dec, Bin, etc.).
o Choose the display. (i.e. for decimal numbers, the choices are degrees,
radians, or gradients.)
o Notice the additional keys available.
o Perform the calculation.
Paint:
= Click on Start = All Programs = Accessories = Paint
= Seeing the Tools
= The tools used in Paint are the Tool Box, the Color Box, the Status Bar, and the Text
Toolbar.
=  On the Menu Bar, click on View and notice the list of tools.
= Atool which has a check mark in front of it is showing.
= Clicking on an item to remove the check mark causes the tool to not be displayed on
the screen.
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Creating a Picture:

Set the Image Size by clicking on Image = Attributes...

Note: Set the Image Size to match the screen resolution of the computer creating a
picture to be used as Desktop wallpaper (such as 800 x 600, 1024 x 768).

Create a picture using the drawing tools.

Editing a Picture

Open a picture by clicking on the Menu Bar on File = Open.

Navigate to the location of the desired picture.

Click on the desired picture.

Click on the Open button.

On the Menu Bar, click on Edit 2 Undo (Windows Paint only undoes the last 3
steps).

Rotating/Flipping a Picture:

On the Menu Bar, click on Image - Flip/Rotate.
Choose Flip Horizontal, Flip Vertical, or Rotate at an angle.
Click on OK.

Erasing Part of a Picture:

In the Tool Box, click on the Eraser tool.

In the bottom of the Tool Box, choose the size of the eraser.
The color of the eraser is the background color.

Click and drag over the area to be erased.

Adding Text:

In the Tool Box, click on the Text tool.
Click and drag a text box onto the picture.
Notice the Text Toolbar. If the Text Toolbar does not appear, on the Menu Bar, click
on View > Text Toolbar (click on the down arrows and choose a font, font size, and
attributes from the Text Toolbar). Be careful not to click outside the text box.
Clicking outside the text box sets the text on the picture.
Choose a text color from the Color Palette in the Color Box.
Type the desired text.
Formatting Text
o Select the text.
o Inthe Text Toolbar, click on the down arrows and choose a new font, size, or
attribute and/or choose a color from the Color Palette.
Resizing a Text Box
o Place the cursor over a sizing handle located on any corner or the top,
bottom, left, or right side of the box (the cursor changes to a two-headed
arrow).
o Click and drag to change the text box to the desired size.
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=  Moving a Text Box

©)

©)

Place the cursor on the edge of the box. (The very tip of the arrow needs to
be right on the edge.)
Click and drag the text box to the desired location.

= Adding Color

©)

o O O

0O O O O o0 O O O O O

o

With the Fill Bucket

In the Tool Box, click on the Fill with Color button.

In the Color Box, click on the desired color.

Click in the area to be colored (Warning — The area being colored must be a
closed curve, or the color will leak out into other areas of the picture.
With the Brush

In the Tool Box, click on the Brush button.

In the Color Box, click on the desired color.

Click and drag over the area to be colored.

Picking a Color

A precise color can be chosen to match the picture.

Zoom in on the desired area to see greater detail.

In the Tool Box, click on the Color Pick button.

Click on the desired color in the picture.

Choose the Fill Bucket or the Brush as desired.

Add color to the desired portion of the picture.

= Saving a Picture

On the Menu Bar, click on File = Save As...

Navigate to the desired location to save the picture (My Pictures is the usual
location).

Type in a name in the File name box.

Choosing a File Type

Notice the File Type (to use the picture in other programs, change the file
type to JPEG).

Click on Save

Windows Media Player 10

Some of Windows Media Player’s functions work best with a live Internet
connection.
=  Opening Windows Media Player

o

Click on Start = All Programs = Accessories = Windows Media Player

= Playing music from a CD:

@)
@)

Place a music CD into the CD-ROM drive

If the Audio CD window opens, choose Play Audio CD using Windows Media
Player

Click on OK (if the CD does not automatically start to play, click on the down
arrow next to Now Playing, and choose the CD-Rom drive).
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= Media Player Controls:
o Buttons
= Play/Pause - Click on the Play button to play the selection. While the
selection is playing, the Play button becomes the Pause button. Click
on the Pause button to stop the selection but remain in the same
location in the song.
= Stop - Click on the Stop button to stop the selection and return to the
beginning.
= Previous and Next - Click on the Previous button to move to the
previous track. Click on the Next button to move to the next track.
= Mute - Click on the Mute button to mute the sound. The music/sound
continues to play.
=  Volume - Click and drag the Volume slider to adjust the volume. This
controls the volume of the selection leaving the computer. Volume of
the computer speakers is controlled on the speakers.
Switch to Skin Mode:
= Click on the Switch to Skin Mode button to switch to Skin Mode.
= Return to Full Mode
= (Click on the Return to Full Mode button while in Skin Mode to return to Full Mode.
Location and Repeat/Shuffle button:
= The numbers indicate the amount of time left in playing the selection. The
Repeat/Shuffle button shuffles the selection order and plays continuously from the
playlist.
Changing Tracks:
= Double click on the desired track in the Playlist to play that track.
Moving to a Location in a Song:
= Click on the slider bar above the control buttons on the desired location in the
selection.
Visualizations:
= (Click on the Now Playing tab.
= C(Click on the Select Now Playing Options button (down arrow).
= Place the cursor over Visualizations and then slide over and choose the desired
visualization or choose No visualization.
o To change to the next or previous visualization, click on the
= Previous visualization button or the Next visualization button.
o To see the visualization full screen, double click in the middle of the
visualization.
=  To return from full screen visualization, double click in the middle of the
visualization.
= Now Playing - Displays the selection currently playing with a list of the songs in the
album on the right.
= Quick Access Panel This is a small down arrow between Now Playing and Library. It
gives quick access to the selections on the computer.

Wilderness Coast Public Libraries computer training & some equipment are made possible by a
Library Services and Technology Act (LSTA) Grant administered by the State Library of Florida.



WILDERNESS COAST PUBLIC LIBRARIES
Microsoft Windows XP ( Level One)

DEANNA D. RAMSEY, TECHNOLOGY INSTRUCTOR

= Library Displays the contents of the library on the computer. The left window
displays the various locations. The middle window displays the selections with the
title, artist, and the album, length, etc.

WordPad
WordPad is a very basic word processor which does not contain the functionality of major
word processing applications, such as WordPerfect or Microsoft Word.

Starting WordPad:
= (Click on Start = All Programs > Accessories = WordPad.
= The Window:
= Menu Bar - The Menu Bar contains the important selections for creating the desired
document.
o Click on the desired item with the mouse
o Click on View and notice the choices of Toolbar, Format Bar, Ruler, and
Status Bar. A checkmark in front of an item means it is showing. Click on the
desired item to show it or hide it.
= Toolbar - The Toolbar contains icons
o Place the cursor over the icon and the name of the icon will appear.
= Format Bar - The Format Bar contains controls for formatting the document.
o Down arrows allow choices of font, font size, and font script.
o Buttons allow choices for bold, italic, underline, font color, font justification,
and bullets.
Ruler - The Ruler measures the location of the text left to right.
= Status Bar - The Status Bar is at the bottom of the window.
Opening a Document:
= On the Menu Bar, click on File = Open (or click on the Open button on the Toolbar).
=  Choose the name of the file to work with and click on the Open button.
Moving Around in the Document:

B AITOW KBYS e e e e e s e e Move short distances.
Lol oY |1 - 7Y PR Slide smoothly through the document.
= Page Up/Page DOWnN.........ccccuveeeecrneennns Move through the document screen by screen.
N = [o] 0 T = 2 Move to the beginning of a line of text.
L Y Ve I =Y 2 Move to the end of a line of text.
= Control Home....ooooiioeireeeeee e, Move to the beginning of the document.
B CoNtrol ENd....eeeieiieeiiiieec e Move to the end of the document.

Selecting Text:
= Selecting Random Text
o Move the cursor to the beginning of the text to be selected.
o Click with the left mouse button and drag the cursor to the end of the text to
be selected.
o Release the mouse button.
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= Selecting a Single Word
o Two (2) clicks in the middle of a word selects the word.
= Selecting a Sentence
o Hold down the CTRL key.
o Click on the sentence you wish to select.
= Selecting a Paragraph
o Three (3) clicks in the middle of a paragraph selects the paragraph.
= Selecting the entire Document
o Place the cursor to the left margin directly across from the text to be selected
and click Three (3) times.
Moving Text:
= Cutting and Pasting Text
o Select the text to be cut.
o Click on the Cut button or Edit = Cut.
o Click where the selected text is to be pasted.
o Click on the Paste button or Edit - Paste.
= Copying and Pasting Text
o Select the text to be copied.
o Click on the Copy button or Edit = Copy.
o Click where the selected text is to be pasted.
o Click on the Paste button or Edit - Paste.
= Dragging Text
o Select the text to be moved.
o Place the cursor in the middle of the selected area and drag the text to the
new location.
o Release the mouse button.
o Be sure to watch the shaded marker to see where the text will be placed.
Corrections:
o Insert or Overtyping - The computer will either insert (place the new text into
the current text) or overtype (replace the current text with the typed text).
o Insert moves the text to the right as text is entered.
o Overtyping replaces the text to the right with the text being entered.
Deleting Text:
= The Backspace key erases characters to the left of the cursor.
= The Delete key erases characters to the right of the cursor.
Undo and Redo:
= To reverse the last change made, click on Edit = Undo OR click on the Undo button.
Document Orientation - Landscape or Portrait:
= On the Menu Bar, click on File > Page Setup.
= |n the Orientation section, click on Portrait or Landscape.
= C(Click on OK (the Preview shows a general picture of a page).
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Margins:
=  On the Menu Bar, click on File - Page Setup.
= In the Margins section, enter the numbers for Left, Right, Top, and Bottom, margins.
= Click on OK.
Formatting Fonts with the Formatting Toolbar:
= Select the text to be changed.
= C(Click on the down arrow of the Font box on the toolbar and choose the desired font.
= Click on the down arrow of the Font Size box and choose an appropriate size.
= Click on the Color button and choose a color for the font (for font sizes not in the list,
click in the box and type the desired number).
Alignment:
= Click in the title or paragraph.
= Click on the appropriate alighnment button on the toolbar.
o Left Align — Text aligns to the left with an uneven edge on the right.
o Center — Text aligns to the center.
o Right Align — Text aligns to the right with an uneven edge on the left.
Creating a Bulleted List:
= Select the text to become a bulleted list.
= C(Click on the Bullets button on the toolbar.
Turning Off Bullets:
= Select the bulleted list.
= C(Click on the Bullets button on the toolbar.
Inserting Date and/or Time:
= C(Click where the current date or time is to be inserted.
= Onthe Menu Bar, click on Insert = Date and Time.
= C(Click on the desired format.
= C(Click on OK.
Tab Stops:
= Default Tab Stops
o Tab stops are set for every .5 inches by default.
= Setting a Tab Stop
o On the Menu Bar, click on Format = Tabs.
o Enter the number in top box to indicate the tab stop location.
o Click on the Set button.
o Click on OK.
= (Clearing a Tab Stop
o On the Menu Bar, click on Format = Tabs.
o Click on the tab stop to be cleared.
o Click on the Clear button.
o Click on OK.
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= C(Clearing All Tab Stops from Text

o On the Menu Bar, click on Format = Tabs.

o Click on the Clear.

o Click on OK.
= Changing the Position of a Tab Stop
= On the Ruler, click on the tab stop and drag it to the desired location.
= Find

o On the Menu Bar, click on Edit p Find....

o Inthe Find what box, enter the word or phrase to be found.

o Click on the Find Next button.
= Find and Replace
On the Menu Bar, click on Edit p Replace....
In the Find what box, enter the word or phrase to be found.
In the Replace with box, enter the word or phrase to replace it with.
Click on the Find Next button to find the next instance of the word(s).
Click on the Replace button to replace that instance of the word(s).
Click on the Replace All to replace all instances of the word(s).

o Close the window.
=  Print Preview

o Print Preview displays the document as it will appear when printed.
On the Menu Bar, click on the File = Print Preview.
Use the Next Page and Previous Page buttons to move from page to page.
Use the Zoom In and Zoom Out buttons to look more closely at a page.
Click on the Print button to print the document.

o Click on the Close button to close Print Preview.
= Printing the Document

o Quickly Printing to the Default Printer

o On the toolbar, click on the Print icon (the print job is immediately sent to

the currently selected printer).

= Printing from the Menu Bar

o On the Menu Bar click on File > Print.
In the Select Printer section, click on the desired printer.
In the Page Range section, decide what pages to print (All, Current or Range).
In the Copies section, indicate how many copies.
Select the decide number of copies to print.
Click on the Print button.

o O O O O O

@)
@)
@)
@)

O 0O O O O
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Saving Documents

= On the Menu Bar, click on File = Save As.

= Notice where the document is being saved (Windows defaults to the My Documents
Folder).

= To Change locations click on the down arrow next of the Save in box and choose the
desired folder.

= Typein a File name.

= (Click on the Save button.

Closing a Document
= C(Click on the X in the top right corner of your screen.
=  OR on the Menu Bar, click on File = Exit.

Opening Documents
= (Click on Start > My Documents.
= Locate the document to be opened (double click on folders to open them as
needed).
o Pictures are frequently stored in My Pictures.
o Music is frequently stored in My Music.
= Double-click on the document to open it (click on Start >Recent Documents to open
recently used documents).

Using Windows Help and Support
e Click on Start = Help and Support.

e Click on desired topic from the menu on the left.

* To return back to the home page, click on the Home button.

* To return to the previous screen, click on the Back button.

e To search for specific topics, use the search box in the upper right corner.
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